
Adobe Photoshop CC 
October 2018 Update

Welcome to the latest Adobe Photoshop CC bulletin update. This 
is provided free to ensure everyone can be kept up-to-date with the 
latest changes that have taken place in Photoshop.

This bulletin includes basic information about some of the latest 
features that are new in Photoshop CC. The features described 
here will be accessible to all Creative Cloud subscribers and those 
who have purchased the current version of Photoshop CC. For a 
complete description of Photoshop’s tools and step-by-step tutorials, 
I recommend you buy the Adobe Photoshop CC for Photographers: 
2018 Edition book.
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Figure 1 The Content-Aware Fill panel.

New Content Aware Fill
The new Content-Aware Fill feature now gives you full control over the 
content-aware fill process, and provides you with a complete workspace 
to work with. To use, go to the Edit menu and choose Content-Aware 
Fill. This opens a live preview window showing the content-aware fill 
outcome, an Options bar, a Tools panel and Content-Aware Fill panel 
(shown in Figure 1). The green shaded area in the preview represents 
the area the content-aware fill will analyze and sample from. You can 
turn this overlay on and off via the Content-Aware Fill panel.
	 The Toolbar Sampling Brush tool (b) can be used to paint over 
the working image preview to remove from the sample area. As you 
do this, you will notice how Photoshop updates the content-aware fill 
preview. Hold down the A key to temporarily switch the Sampling 
Brush toll from the Erase mode to the Add mode.
	 Should you need to, the Lasso and Polygonal Lasso tools (l) can 
be used to refine the original selection area. You can click and drag to 
add to the selection, or hold down the A key to subtract and make 
use of the buttons in the Lasso tool mode Options bar to modify the 
selection edit behavior. Adding a small amount of Feather here can 
help achieve a smoother edge transition. Then there are the Expand 
and Contract buttons, where you can use the accompanying Pixels field 
to determine how much to expand or contract by. These buttons can be 
used to further modify the selection area, making it wider or tighter.
	 In the Content-Aware Fill panel Sampling Options section you can 
adjust the opacity of the shaded area, or change the color if necessary. 
By default, the shaded area indicates the Sampling area. But you 
can set this to indicate the Excluded areas instead. The Fill settings 
can be used to adjust the sampling adaptation method. The Color 
Adaptation settings allow the color and contrast to adapt, where you 
can choose to select None, Default, High or Very High. The Rotation 
Adaptation determines how much the content-aware fill can flexibly 
rotate the sampled pixels to create a better match. With higher Rotation 
Adaptation settings, the content-aware fill will be more randomly 
rotated. The Scale checkbox allows the sample content to resize. 
Therefore, if there is a shift in perspective between the areas you are 
filling and the areas you are sampling from, the Scale option can help 
you achieve a better fill. The Mirror option applies a horizontal flip 
to the sampled data, which can help you achieve a better match for 
symmetrical subjects.
	 Under the Output settings you can choose to output to a Duplicate 
layer, or to the current layer, or to a New layer, that contains just the 
content-aware filled pixels.
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2 In this step I refined the sample area (indicated by the green overlay) and adjusted the Fill 
Settings to achieve a neater fill that matched the surrounding areas.

1 Here, I wanted to remove the poster hanging outside this Venice museum. I made a  basic 
selection of the poster and chose Edit ➯ Content-Aware Fill. The initial fill was rather messy.
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Paint Symmetry
Paint symmetry is supported for the Photoshop paint tools and is no 
longer only available as a Technology Preview. To use, select a paint tool 
such as the Brush tool. From the Options bar (Figure 2) click on the 
Paint Symmetry icon (circled) to reveal the Symmetry menu options. 
Here, you can choose one of the guides from the menu list, which now 
includes Radial and Mandala options, or select a current, active pen 
path. You can also use this menu to turn Symmetry on or off or hide the 
symmetry axis.

Figure 2 The Brush tool Options bar plus Symmetry menu options.

Figure 4 An example of paint symmetry being used with the Dual Axis guides.

After selecting a guide this creates a reflecting plane, or two planes as 
shown in the Dual Axis example in Figure 4. As you paint the brush 
strokes you apply are reflected in the other plane or planes. If you select 
the Radial or Mandala options you’ll see the Symmetry dialog shown 
in Figure 3. Note that bristle tip brushes cannot be used when paint 
symmetry is enabled. Only regular brush tips will work. While most 
types of brush strokes are reflected as mirror images it is interesting to 
paint with Scattering enabled in the Brush Settings. This creates a mirror 
brush stroke, but with a certain randomness, which you can see in the 
peach colored brush strokes using the Scattered Leaves brush preset.

Figure 3 The Symmetry dialog, which in 
this case is for the Mandala option, where 
you can choose the number of segments 
to apply.
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User experience updates

Instant blend mode previews
As you over each of the blend mode options you can instantly preview 
the result on screen. For example, if you want to change the blend 
mode for a layer you can now very quickly whizz through the blend 
mode options without having to click on each in turn (Figure 5).

Multi-undo
The undo/redo behavior has been changed such that the Cz (Mac), 
Lz (PC) shortcut is now a progressive undo rather than a toggle 
action. This also now appends the name of the command you have 
just undone. Therefore, if you undo a Move tool adjustment and go to 
the Edit menu, it will say ‘Undo Move’. Likewise, the Redo commands 
(Cz [Mac], Lz [PC]) will get named too.

Math in number fields 
If a number field is active you can enter a math equation to calculate 
the value. Use - to subtract, + to add, * to multiply and / to divide. For 
example, if you type ‘130/2’, this will enter a calculated value of 65.

Proportional transform 
Transforms applied to pixel layers, type layers or selections (but not 
paths) are now made proportional by default. This means that when 
you drag a boundary box corner or side handle, the transform scales in 
size. Unless, that is, you hold down the S key while dragging. This 
new behavior essentially reverses the function of the S key. The 
Reference point/ pivot point (the cross hair that appears in the center) is 
now hidden by default, but can be re-enabled via the Tools preferences.

Distribute layers
When the Move tool is selected and you have multiple layers selected, 
there are now new buttons in the Move tool Options bar (Figure 6) that 
can be used to distribute vertically or distribute horizontally.

Figure 5 See an instant preview as you 
roll the cursor down the blend modes list.

Figure 6 The Move tool Options bar with the new Distribute buttons highlighted.
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Auto commit 
Previously, whenever you placed an object, entered new text, or were 
in a Crop or Transform mode, you would have to confirm by clicking 
on a tick box in the Options bar, or press R or E. Now, you 
can more easily auto-commit any of the above actions by clicking 
outside the object boundary, or indeed anywhere else in the Photoshop 
interface, such as clicking to select a new tool.

Interface appearance
The Photoshop interface has been updated with new on-canvas 
controls. In Figure 7 below you can see a comparison between the Crop 
controls in Photoshop CC 2018 (left) and Photoshop CC 2019 (right). 
The new bounding box and handles are now more prominent, which 
makes them easier to locate, especially on a high resolution display. 
However, because the handles now fall outside a bounding box you 
do always have to enlarge image document windows to reveal the gray 
canvas, or work in a full screen mode in order to see and access them.

Figure 7 The Crop bounding box in Photoshop CC 2018 (left) and Photoshop CC 2019 (right).

Locking panels 
If you go to the Window menu and choose Workspace ➯ Lock 
Workspace, this will prevent the panels from being rearranged while 
they are locked. You can still adjust the panel widths and relative panel 
heights and reorder panels within a panel group. This new behavior 
only applies when working with the default shipping workspaces. It 
won’t keep custom workspaces locked.
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Color wheel
The Color panel now has a new Color Wheel mode (Figure 8). Select 
a Hue value  by clicking in the outer circle and dragging to select 
the desired color hue. Then, separately, adjust the Brightness value 
by dragging up or down and adjust the Saturation by dragging left 
or right. The color wheel mode now makes it easier to choose color 
harmonies. To select a complimentary color, just click on the opposite 
side of the wheel to the color hue that is currently selected.

Layer naming
Photoshop CC 2019 now handles long layer names differently. Layer 
names are now truncated in the middle rather than the end.

Tool colors
In the Guides, Grid & Slices preferences (Figure 9) there is now a 
Control Color option which can be used to determine the color of the 
boundary box for transforms and when using the Frame tool. It may 
be useful to be able to alter the color sometimes to aid visibility when 
working on a particular project.

Figure 8 The Color panel Color Wheel 
mode.

Figure 9 The Guides, Grid & Slices preferences.
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Home Screen
The new, updated Home Screen (Figure 10) appears by default 
whenever there are no documents are open. Or, if there are documents 
open, you can open it by clicking on the Home button in the Options 
bar (circled in Figure 11). In the learn mode you can access online 
tutorial movies. If you find it annoying you can disable the home screen 
via the General preferences and then restart Photoshop.
	 Meanwhile, in the Learn panel you’ll find built-in tutorials that 
teach you Photoshop techniques using supplied demo images. After 
completing you can then repeat the steps using one of your own images.

Figure 10 The Photoshop CC Home Screen.

Figure 11 The Options bar with the Home Button (circled).
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Figure 12 The Keyboard Shortcuts and Menus Taskspaces shortcuts options.

Flip Canvas
To get a fresh perspective on your artwork, you can now go to the 
View menu and choose Flip Horizontal to quickly flip the canvas view 
horizontally. This quick step does not actually transform the pixels. It 
just lets you preview the image differently.

Shortcuts for Taskspaces
If you go to the Edit menu and choose Keyboard Shortcuts this opens 
the Keyboard Shortcuts and menus dialog shown in Figure 12. There is 
now a new Taskspaces option that allows you to customize the assigned 
shortcuts for the Select and Mask and Content-Aware modal dialogs. 
So far it is just these dialogs where you can edit the shortcuts.
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Adobe Photoshop CC for Photographers: 2018 Edition book

By Martin Evening

Adobe Photoshop CC for Photographers: 2018 Edition is published by 
Focal Press, an imprint of Taylor & Francis.

768 pages + Online website
Order via Focal Press secure online ordering: www.routledge.com
For more information go to the book website:  www.photoshopforphotographers.com

https://www.routledge.com
http://www.photoshopforphotographers.com
http://www.facebook.com/MartinEveningPhotoshopAndPhotography/

